Bau- und Bedienungsanleitung -

Bausatz-Artikel-Nr.: 160231
Version: 1.1
Stand: September 2023

ELV Erweiterungsmodul
NodeMCU

ELV-EM-NodeMCU

Technischer Kundendienst
Fir Fragen und Auskiinfte stehen lhnen unsere qualifizierten technischen Mitarbeiter gerne zur Verfliigung.

ELV-Technischer Kundendienst - Postfach 1000 - 26787 Leer - Germany
E-Mail: technik@elv.com
Telefon: Deutschland und Osterreich: (+49) 491/6008-245 - Schweiz 061/8310-100

Haufig gestellte Fragen und aktuelle Hinweise zum Betrieb des Produkts finden Sie bei der Artikelbeschreibung
im ELVshop: www.elv.com

Reparaturservice

Fur Gerate, die aus ELV Bausatzen hergestellt wurden, bieten wir unseren Kunden einen Reparaturservice an.
Selbstverstandlich wird Ihr Gerat so kostenglnstig wie moglich instand gesetzt. Im Sinne einer schnellen Abwicklung
fuhren wir die Reparatur sofort durch, wenn die Reparaturkosten den halben Komplettbausatzpreis nicht Gberschreiten.
Sollte der Defekt groBer sein, erhalten Sie zunachst einen unverbindlichen Kostenvoranschlag.

Bitte senden Sie Ihr Gerat an: ELV - Reparaturservice - 26787 Leer - Germany

ELV Elektronik AG - Maiburger StraBe 29-36 - 26789 Leer - Germany
Telefon 0491/6008-88 - Telefax 0491/6008-7016 - www.elv.com

www.elv.com



n Bau- und Bedienungsanleitung

Smartes Prototyping

ELV Erweiterungsmodul NodeMCU - ELV-EM-NodeMCU

Das ELV-Modulsystem bietet eine groBe Vielfalt an unterschiedlichen Applikationsmodulen zur Erfassung diver-
ser MessgrioBen wie z. B. Temperatur, Luftfeuchte, Helligkeit, Position oder Beschleunigung. Mit dem ELV Erweite-
rungsmodul NodeMCU (ELV-EM-NodeMCU) ist es nun auch méglich, die Applikationsmodule in Kombination mit einem
NodeMCU-Entwicklungsboard zu verwenden. In diesem Beitrag werden zunachst die Grundlagen der NodeMCU er-
lautert und das Schaltungsbild des Erweiterungsmoduls dargestellt. AnschlieBend wird die Programmierung in der
Arduino IDE beschrieben anhand der in Bild 1 zu sehenden ELV Applikationsmodule Temperatur und Luftfeuchte
(ELV-AM-TH1)[1], Luxmeter (ELV-AM-LX1)[2] und Luftdruck (ELV-AM-AP)[3]).
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Infos zum Bausatz
ELV-EM-NodeMCU

Schwierigkeitsgrad:
leicht

Bau-/Inbetriebnahmezeit:
ca.0,256h

Besondere Werkzeuge:
keine

Loterfahrung:
nein

Programmierkenntnisse:
ja(Arduino-Programmierung)

Elektrofachkraft:
nein

Was ist eine NodeMCU?
Der Begriff ,NodeMCU” beschreibt sowohl eine Hardwareplattform als
auch eine Softwarebibliothek. Beide Komponenten basieren auf einem
ESP8266- oder ESP32-Controller des chinesischen Unternehmens
Espressif Systems, der sich vor allem durch einen glinstigen Preis und
einintegriertes WLAN-Modul auszeichnet[4]. Das Board ist daherideal
fUr die prototypische Umsetzung neuer Hard- und Firmwarekonzepte.
Hardwareseitig unterstitzt der Mikrocontroller des NodeMCU-
Entwicklungsboards ein breites Spektrum an Seriellen Schnittstellen
wie I12C, SPI oder UART. Uber GPIO-Pins (General Purpose Input Output)
konnen Sensorenund Aktoren angeschlossen werden. Zu den weiteren
Komponenten gehoren eine USB-Schnittstelle zur Spannungsversor-
gung und Programmierung, ein UART-zu-USB-Wandler fur die seriel-
le Ausgabe von Sensordaten, ein Spannungsregler zur Regelung der
Eingangsspannung auf 3,3V sowie zwei Taster flr das Aktivieren des
Bootloader-Modus und das manuelle Zurlicksetzen des Boards.
Firmwareseitig existieren durch eine groBe Community bereits viele
Libraries fur die Programmierung der NodeMCU. Am haufigsten erfolgt
die Programmierung in Arduino, da die Syntax und Entwicklungsum-
gebung einen leichten Einstieg ermdglichen. Darlber hinaus werden
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jedoch u. a.auch C/C++, Lua-Script oder Python un-
terstitzt [5].

Das ELV Erweiterungsmodul NodeMCU wurde
fur die Joy-IT Entwicklungsplatine NodeMCU mit
einem ESP-WROOM-32-Mikrocontroller entwickelt
- generell ist sie jedoch auch mit allen anderen
NodeMCU-Boards mit ESP32-Mikrocontroller kom-
patibel. Dieser Nachfolger des ESP8266 bietet ne-
ben dem WLAN-Funkmodul auch eine Bluetooth-
LE-Schnittstelle und mehr GPI0-Pins [6].

Bild 2 zeigt exemplarisch die Draufsicht auf die
Joy-IT NodeMCU [7]. Auf dem PCB (Printed Circuit
Board)sind die zuvor genannten Komponenten farb-
lich gekennzeichnet:

- gelb: ESP-WROOM-32 SoC (System on Chip) mit

Tensilica-LX6-Dual-Core-Prozessor
« blau: UART-zu-USB-Wandler(SiliconLabsCP2102)
- griin: Spannungsregler(TI LM1117)

« grau: Bootund Enable Buttons
- orange: Micro-USB-Buchse (Spannungsversor-
gung und Ubertragung der Firmware)

Schaltung

Die Schaltung des ELV Erweiterungsmoduls
NodeMCU (B”d 3) verbindet alle relevanten Pins der Bild 1: NodeMCU mit ELV Erweiterungsmodul NodeMCU und aufgesteckten Applikations-
Applikationsmodule des ELV-Modulsystems mit der  modulen (ELV-AM-TH1, ELV-AM-AP, ELV-AM-LX1)

NodeMCU. Das Erweiterungsmodul wird dabei Gber
die StiftleistenJ1und J2 auf die Applikationsmodule
gesteckt, wahrend die Buchsenleisten J3 und J4 fur
die Aufnahme der NodeMCU-Entwicklungsplatine
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Bild 2: Draufsicht Joy-IT Entwicklungsplatine NodeMCU mit ESP32 Bild 3: Schaltbild des ELV-EM-NodeMCU
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Bild 4: Platinenfotos und Bestlickungsdrucke des ELV Erweiterungsmoduls NodeMCU

Hinweis

Eine gleichzeige Versorgung der NodeMCU und
der angeschlossenen Applikationsmodule Uber
USB und die VDD-Pins sollte vermieden werden,
da es durch unterschiedliche Spannungen und
dem daraus resultierenden Strom zu Beschadi-
gungen der Schaltung kommen kann! Um solche
Probleme zu vermeiden, ist es wichtig, dass die
Stromversorgung eindeutig definiert ist und
keine Mehrfachversorgung stattfindet.

Im Bereich der Seriellen Schnittstellen sind zwei
UART-Schnittstellen nutzbar. Die Pins RX0 und TX0
dienen zur Ubertragung von Firmware und Debug-
Informationen. Falls das angeschlossene Applika-
tionsmodul seine Daten Gber UART bereitstellt, ge-
schieht dies Uber die Pins RX2 und TX2, die mit Pin
19 und 20 von J1bzw. J2 verbunden sind.

Ebenfalls verfligbar ist ein SPl-Interface, bei
dem die Pins D18 (SPI_SCK), D19 (SPI_MIS0) und D23
(SPI_MOSI) auf die Pins 22, 23 und 24 von J2 gefiihrt
werden. Am Pin D5 der NodeMCU muss wahrend
des Startvorgangs ein High-Pegel anliegen. Soll-
te eine weitere angeschlossene Peripherie einen
Low-Pegel an D5 erfordern, kann tiber den Jumper
Jb alternativ der Pin D32 auf den SPI_CS Pin (Pin 21
an J2) gefiihrt werden. So ist eine korrekte Funk-
tionsweise des SPl-Interfaces sichergestellt. Die
I2C-Pins D21 und D22 sind mit den Pins 7 (I2C_SDA)
und 8(12C_SCL)verbunden.

Die Installation von Arduino IDE
wird abgeschlossen |

Arduino IDE wurde auf Threm Computer nstalliert.

Klicken Sie auf Fertigstellen, um den Installations-Assistenten
2u schibefen. I

18 Arduing IDE ausfibren

Fertigstelen

Bild 5: Abschluss der Arduino-IDE-Installation
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Zu den weiteren Verbindungen gehdren die zwei ADC-Pins D25 und
D26, die mit Pin 17 und Pin 18 verbunden sind. Der ADC-Pin D13 kann
funktional zum Auslesen der Batteriespannung genutzt werden.

Nachbau

In Bild 4 sind die Platinenfotos und Bestickungsdrucke des ELV Erwei-
terungsmoduls NodeMCU zu sehen. Da alle Bauteile bereits bestlickt
sind, sind keine Lotarbeiten notwendig.

Installation und Vorbereitung der Entwicklungsumgebung
Hinweis: Die nachfolgenden Installationsanleitung bezieht sich auf die
Arduino IDE in der Version 2.1.0 und das Betriebssystem Windows 11.

Falls die Arduino IDE noch nicht installiert ist, kann diese von der
offiziellen Arduino-Webseite kostenlos heruntergeladen werden [8].
Durch das Befolgen der angezeigten Installationsschritte sollte am
Ende derin Bild 5 zu sehende Dialog erscheinen.

Fir die Verwendung der NodeMCU wird die offizielle ESP32-Biblio-
thek benotigt, in der die Boarddefinitionen enthalten sind. In der Ar-
duino IDE kann der zusatzliche ,Boards Manager” Giber das Menti File >
Preferences hinzugefligt werden. In das Feld ,Additional board mana-
ger URLs"” wird die folgende URL eingetragen (Bild 6)[9]:

https://raw.githubusercontent.com/

espressif/arduino-esp32/gh-pages/ 2

package_esp32_index.json 2

Durch Betatigen des Buttons ,0OK" schlieBt sich der Dialog. Die IDE ent-
halt nun eine weitere Quelle im Boards Manager. Zur Installation der
Boards wird der Boards Manager aus der Seitenleiste ausgewahlt. Dort
kann nun durch den Suchbegriff ,esp32” das entsprechende Package
von Espressif Systems heruntergeladen werden (Bild 7).

Fur die korrekte Nutzung der UART-zu-USB-Schnittstelle muss
der CP210x-Treiber installiert werden. Dieser steht auf der Website
von Silicon Labs zum Download bereit [10]. Die Ausfiihrung der Datei
.CP210xVCPInstaller_x64.exe” startet den Geratetreiber-Installations-
Assistent (Bild 8). Durch das Befolgen der Installationsanweisungen
werden nun automatisch die bendtigten Treiber installiert.

Nach dem allgemeinen Vorbereiten der Entwicklungsumgebung
konnen nun die Bibliotheken fir die Nutzung der Applikationsmodule
eingebunden werden. Zur Nutzung des Applikationsmoduls Luxmeter

Sonstiges:
Stiftleiste, 1x 12-polig, gerade, SMD J1,J2
Buchsenleiste, 1x 15-polig, gerade, SMD J3, J4

Platine ELV-EM-NodeMCU
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Bild 6: Hinzufligen einer neuen Boards-
Manager-URL Preferences

Sketchbook location:

Settings l Network

d:\Arduino2.1.0
[0 Show files inside Sketches
Editor font size: 14
Interface scale: Automatic 160 %
Theme: Light w
Language: English ~ (Reload required)
Show verbose output during  [J) compile (J upload
Compiler warnings None

Verify code after upload
Auto save
[ Editor Quick Suggestions

Additional boards manager URLs: https:/fraw.githubusercontent.com/espressiflarduino-esp32/gh-pages/package_e |o

steht im Downloadbereich des ,ELV Bausatz Lichtsensor OPT3001 mit
I2C-Schnittstelle 12C-LS” [11] der Ordner ,Software Arduino Beispiel-
paket”zur Verfligung.

Nach dem Herunterladen befindet sich in dem Verzeichnis neben
der 12C-LS-Bibliothek auch eine Readme-Datei, die verschoben bzw.
geldscht werden muss, da es sonst zu einer Fehlermeldung beim Im-
portvorgang kommt.

BOARDS MANAGER

esp32
E Type: Al ~

esp32 by Espressif Systems

Boards included in this package: ESP32 Dev Board, ESP32-52 Dev Board,
ESP32-53 Dev Board, ESP32-C3 Dev Board

More info

208 w Bild 7: Installation des

esp32-Package

IR E 8 v 1

WiFiProv

Interrupt
Wire 4

Limitinterrupts
Examples from Custom Libraries Plotter
12C-LS > Polling

v Wait_For_Readyflag

Bild 9: Code-Beispiele der 12C-LS Bibliothek

LIBRARY MANAGER

HDC2080
Type:  All ~
Topic: Al i

Lime Labs HDC2080 by Lime Labs GmbH, Texas Instruments, TinkeringTech,
@stickbreaker

Uses 12C and the Arduino Wire library to communicate with the HDC2080 An Arduino
library to configure and communicate with the Texas Instruments HDC2080 temperature
& humidity sensor

More info

112 INSTALL

Bild 10: Installation der HDC2080-Bibliothek iber den Library-Manager

Willkommen

Mt desem 1 kannen Sie b
instalieren, die zum ordnungsgemalien Ausfhren einiger
Computergerate adfordedich snd.

Hlicken Sie auf "Weiter”, um den Vorgang fortzusetzen,

Weser > Abbrechen

Bild 8: Installation des CP210x-Treibers

Inder Arduino IDE wird nun aus der Mentleiste der
Punkt Sketch = Include Library - Add .ZIP Library
ausgewahlt. Im Datei-Explorer wird der herunterge-
ladene Ordner ,i2c-Is_arduino_lib.zip” ausgewahlt.
Bei erfolgreicher Installation erscheint im Terminal-
bereich die Ausgabe ,Library installed”. AuBerdem
stehen jetzt im Bereich File > Examples > 12C-LS
mehrere Code-Beispiele zur Verfligung (Bild 9).

Die Bibliothek fur den im ELV Applikationsmodul
Temperatur und Luftfeuchte (ELV-AM-THT) verbau-
ten Sensor TI HDC2080 kann direkt aus der IDE he-
raus installiert werden. Dazu wird der Library-Ma-
nager aus der Seitenleiste gedffnet. Durch Eingabe
des Sensornamens erscheint die Bibliothek ,Lime
Labs HDC2080" die Uber den Button ,Install” hinzu-
gefligt werden kann (Bild 10).

Auch die Bibliothek fir den im ELV Applikati-
onsmodul (ELV-AM-AP) verwendeten Drucksensor
Bosch BMP581 kann Uber den Library-Manager her-
untergeladen werden. Durch Eingabe der Sensorbe-
zeichnung erscheint die ,SparkFun BMP581 Arduino
Library”. Diese wird analog zur HDC2080-Bibliothek
installiert.

www.elv.com
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sketch_jul3a.ino

Lo T < N B« ATV TR - TV S

[y
L]

void setup() {

void loop() {

put your main code here, to run repeatedly:

Bild 11: Ansicht eines neuen Arduino-Sketches

00N Owm B W

{'s]

#define AM_LX1 ]

#define AM_TH1 )
#define AM_AP 1

#define HDC2886_ADDR ox40
#define OPT3@01_ADDR ex45
#define BMP581_ADDR ox46

Bild 12: Defines fiir die 12C-Adressen und die Angabe
der angeschlossenen Sensoren

L2
13
14
15
16
17
18
g
20

#if defined (AM_TH1) &R (AM_TH1 == 1)
#include <HDC2080.h>

#endif

#if defined (AM_LX1) && (AM_LX1 == 1)
#include <I2C-LS.h>

#endif

#if defined (AM_AP) && (AM_AP == 1)

#include <SparkFun_BMP581 Arduino_Library.h>
#endif

Bild 13: Einbindung der benétigten Bibliotheken

27
28
29
3e
31
32

#if defined (AM_TH1) &&% (AM_TH1 == 1)
HDC2080 hdc2886(HDC288@_ADDR);

#endif

#if defined (AM_AP) &% (AM AP == 1)
BMP581 bmp581;

#endif

Bild 14: Globale Variablen

37
3g
39
40
a1
42
43
44
45
46

§if defined (AM_LX1) && (AM_LX1 == 1)
void initOPT3001(){

ing des OPT3801
INg PT3ee1

I2C_LS.begin(OPT30@1_ADDR);

I2C_LS.writeConfigReg( I2C_LS_CONFIG_CONT_FULL_806MS );

}

#endif

Bild 15: Initialisierung des Helligkeitssensors OPT3100

www.elv.com

Beschreibung der Firmware

Fir das Auslesen der Sensorwerte wird in der
Arduino IDE unter File > New Sketch ein neuer
Sketch angelegt. Dieser beinhaltet bereits die bei-
den Funktionen ,setup”und ,loop”(Bild 11). Innerhalb
der setup-Funktion befindet sich spater der Code
zur Initialisierung der Seriellen Schnittstelle und der
Sensoren (einmalige Ausfiihrung nach Programm-
start). Die loop-Funktion beinhaltet das zyklische
Auslesen der Sensoren und die Ausgabe der Werte.

Vor dem Beginn der eigentlichen Implementie-
rung werden Praprozessoranweisungen, auch De-
fines genannt, fir eine bedingte Kompilierung des
Codes definiert. Durch diesen Mechanismus verrin-
gert sich die GroBe des spateren Maschinencodes,
da nur die Bibliotheken, Funktionen und globalen
Variablen der tatsachlich angeschlossenen Applika-
tionsmodule geladen bzw. erstellt werden.

Ein weiterer Anwendungsfall von Praprozessor-
anweisungen ist das Anlegen von Bezeichnern, die
dann im Code an der gewlinschten Stelle eingefligt
werden. In diesem Kontext werden so die I2C-Adres-
sen der Sensoren definiert. Bild 12 zeigt alle erfor-
derlichen Defines.

Die Einbindung der Bibliotheken ist Uber den
Menlpunkt Sketch = Include Library mdglich. Dort
befindet sich am Ende der Liste der Bereich ,Con-
tributed Libraries”, aus dem die Eintrage ,I2C-LS",
,Lime Labs HDC2080" und ,SparkFun BMP581 Ardui-
no Library”ausgewahlt werden. Unter Einbeziehung
der zuvor definierten Praprozessoranweisungen er-
gibt sich der Code aus Bild 13.

Neben den Praprozessoranweisungen werden
zwei globale Variablen fir den HDC2080 und den
BMP581bendtigt (Bild 14).

Da ein modularer Code leichter zu warten und zu
erweitern ist, wird fir jeden Sensor eine separate
Initialisierungsfunktion implementiert.

Fir die Initialisierung des Helligkeitssensors
OPT3100 (Bild 15) wird das Objekt ,12C_LS" aus der
zugehorigen Library genutzt. Die Funktion ,begin”
initialisiert die 12C-Peripherie und weist die Uber-
gebene Adresse zu. Der zweite Befehl startet die
zyklische Messung der aktuellen Helligkeit in einem
Intervall von 800 ms.

Die Initialisierung des Temperatur- und Luft-
feuchtesensors HDC2080 (Bild 16) setzt sich aus drei
Komponenten zusammen: Zunachst wird die Seriel-
le Schnittstelle initialisiert und der Sensor zurlck-
gesetzt (Zeile 52 und 53). Es folgt die Konfiguration
des Messmodus, der Messfrequenz und der Auf-
I6sung der Messwerte (Zeile 56-59). AbschlieBend
wird der Messvorgang gestartet (Zeile 62).

In der Initialisierungsfunktion des Drucksensor
BMP581 (Bild 17) wird Gberprift, ob die Verbindung
zum Sensor erfolgreich hergestellt werden konnte
(Zeile 71). Solange dies nicht der Fall ist, wird eine
Fehlermeldung ausgegeben (Zeile 74). Die Ursachen
fir das Fehlschlagen kénnen in einer falschen [2C-
Adresse oder einem fehlerhaft angeschlossenen
Applikationsmodul liegen. Erst wenn die Initialisie-
rung erfolgreich verlief, wird die Erfolgsmeldung
aus Zeile 80 ausgegeben.
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48 #if defined (AM_TH1) &% (AM_TH1 == 1) 67 #if defined (AM_AP) && (AM_AP == 1)

49 void initHDC2088(){ 68 void initBMP581(){

1) 69

51 // Initialisiserung des HDC2088 78 // Initialisierung des Sensors

52 hdc288@.begin(); 71 while(bmp581.beginI2C({BMP581_ADDR) != BMPS5_OK){
53 hdc2888.reset(); 72

54 73 //Keine Verbindung zum Sensor méglich

55 //Konfiguration des HDC2@8@ 74 Serial.println("Error: BMP581 nicht verbunden!");
56 hdc2888. setMeasurementMode (TEMP_AND_HUMID) ; 75

57 hdc2888@.setRate(TWO_HZ); 76 //Wartezeit zum nachsten Versuch

58 hdc288@.setTempRes(FOURTEEN_BIT); 77 delay(leee);

59 hdc2088. setHumidRes (FOURTEEN BIT); 78 }

60 79

61 //Beginn der Messungen 80 Serial.println("BMP581 verbunden!");

62 hdc288@.triggerMeasurement(); 81

63 82 }

64 } 83  #endif

65 #endif

Bild 17: Initialisierung des Drucksensors BMP581
Bild 16: Initialisierung des Temperatur- und Luftfeuchte-

sensors HDC2080

84 void setup() {

85
86 // Initialisierung der seriellen Ausgabe
In der ,setup”-Funktion (Bild 18) wird zu- :; Sevial.begin( 13200},
nachst die Serielle Schnittstelle (UART) mit - 1 Teiehaiis herun da SHISOR
einer Bitrate von 115200 Bit/s ged&ffnet (Zei- 98 #if defined (AM_LX1) && (AM_LX1 == 1)
|e 87) 91 initOPT3ee1();
AnschlieBend folgen in Abh&ngigkeit der zi Sehedy
zuvor genannten Defines die Aufrufe der od #if defined (AM TH1) 8& (AM TH1 == 1)
Initialisierungsfunktionen der angeschlosse- 95 initHDC2888();
nen Applikationsmodule bzw. Sensoren (Zeile 96 #endif
97
90_]_00)' . . ) ) 98 #if defined (AM_AP) 8& (AM AP == 1)
Die ,loop”-Funktion wird automatisch nach 99 initBMPS81();
der ,setup”-Funktion aufgerufen. In ihr befin- 1ee #endif
den sich samtliche Ausgaben der Firmware, 12; :

wie die Zeit in Millisekunden nach Programm-
start und die formatierte Ausgabe der Sen-
sorwerte. Wie bereits in der ,setup”-Funktion
werden dabei Praprozessoranweisungen ge-
nutzt, um einerseits die GroBe des Codes zu

Bild 18: Funktion ,setup”

reduzieren und andererseits die Ausgabe an- 164  void loop() {
zupassen (Bild 19, Bild 20). 165
AbschlieBend erfolgt die AUSgabe eines 186 / .-Hl‘-ng:',..-:l.":l:ll_*n"L tstempels in ms seit Beginn der Ausfiihrung
A . . 187 Serial.print("Time (ms) :");
Zeilenumbruchs sowie der Aufruf der Funkti- 108 Serial.print(rillis());
on ,delay” zur Verzégerung der nachsten Aus- 109
gabe um 800 ms (Bild 21). 118 #if defined (AM_LX1) B& (AM_LX1 == 1)
111
112 //Ausgabe des Helligekeitswerts des OPT3@81
113 Serial.print("\tBrightness (1x): ");
114 Serial.print(I2C_LS.readluxFloat(), 2);
115
116 #endif
117
122 Serial.print(hdc2@88.readTemp()); 118 #if defined (AM_TH1) && (AM_TH1 == 1)
123 Serial.print("\tHumidity (%): "); 119
124 Serial.print(hdc2088.readHumidity()); 128 //Ausgabe der Temperatur und Luftfeuchte des HDC2888
125 v 5 Serial.print("\tTemperature (C): ");
4%, | it Bild 19: ,loop*-Funktion (Teil 1)
127
128 #if defined (AM_AP) and (AM_AP == 1)
129
138 //Auslesen der Sensordaten des BMP581
131 bmp5_sensor_data data = {@,8};
3152 bmp581, getSensorData(&data);
133 148 //Erzeugung eines Zeilenumbruchs nach Ausgabe der W
134 //Ausgabe des Luftdurcks 141 Serial.println();
135 Serial.print("\tPressure (Pa): “); 142
136 Serial.print(data.pressure); 143 //Abstand zwischen zwei Messungen (ms)
137 144 delay(808@);
138 #endif 145 }
Bild 20: ,loop"-Funktion (Teil 2) Bild 21: ,loop”-Funktion (Teil 3)
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¢ ESP32 Dev Module ” Select Other Board and Port X

Select both a Board and a Port if you want to upload a sketch.

BOARDS M/ ,;; ESP32 Dev Module w \ If you only select a Board you will be able to compile, but not to upload your sketch.
' COM8
BOARDS PORTS
Select other board and port...
E Type: £ esp32 dev module Q

Bild 22: Auswahl des Boards und COM-Ports
ESP32 Dev Module v COMS8 Serial Port (USB) v

ESP32C3 Dev Module

Flashen der Firmware und ESP32S2 Dev Module
AnSICht der Ausgabe FSP3253 Nev Madule O show all ports
Fir das Aufspielen der Firmware wird die
NodeMCU mit den angeschlossenen Applikations-
. N . CANCEL
modulen Uber ein Micro-USB-Kabel mit dem Com- m

puter verbunden. In der IDE muss dann ,ESP32 Dev  Biid 23: Auswahl des Boards und COM-Ports

Module” und der Port ausgewahlt werden, an dem

die NodeMCU angeschlossen ist (Bild 22).
Fallsandieser Stellenochnicht dasrichtige Board

bzw. der richtige Port hinterlegt ist, kann dies tUber
die Option ,Select other board and port” angepasst
werden. In dem sich 6ffnenden Dialog (Bild 23) er-
scheint das Bord nach Eingabe des entsprechenden
Suchbegriffs. Auf der rechten Seite befindet sich

zudem eine Ubersicht aller verfiigbaren COM-Ports.
Die Firmware kann nun auf die NodeMCU Ubertra-  Bild 24: Buttons zum Verifizieren und Hochladen der Firmware auf die NodeMCU

gen werden. Mithilfe des Buttons ,Verify” wird der

Code zunachst Uberprift und anschlieBend kompi-

liert (Bild 24, rot). In der Output-Konsole sollte dabei

keine Fehlermeldung erscheinen, sondern lediglich  Fazit und Ausblick

die Auslastung des Speichers (Bild 25). Sofern der Indiesem Artikel wurde das Erweiterungsmodul NodeMCU vorgestellt.

Vorgang erfolgreich war, kann die Firmware nun in  Nach einer kompakten Definition des Begriffs,NodeMCU"und einer Be-

den Speicher der NodeMCU geladen werden. Dies schreibungdes Schaltbildswurde auf die Firmware fir die Verwendung

geschieht iber den ,Upload”-Button (Bild 24, blau). der Applikationsmodule Temperatur und Luftfeuchte (ELV-AM-TH1),
Die Ausgaben der NodeMCU kdnnen nun im Se-  Luxmeter (ELV-AM-LX1)und Luftdruck (ELV-AM-AP)eingegangen. Ins-

riellen Monitor eingesehen werden. Dieser wird gesamterdffnen sich durch die NodeMCU und das Erweiterungsmodul

Uber das Menl Tools > Serial Monitor gedffnet und  in Kombination mit den ELV-Applikationsmodulen neue Mdglichkeiten

zeigt fortlaufend die gemessenen Sensorwerte an  zum Messen, Speichern und Weiterverarbeiten von Sensorwerten.

(Bild 26). Neben dem integrierten Seriellen Moni-

tor eignen sich auch weitere Tools wie PuTTY oder

HTerm zur Uberwachung der Ausgaben [12],[13]. Geréate-Kurzbezeichnung: ELV-EM-NodeMCU
Damit der Zeitstempel bei 0 beginnt, kann der Re- = Umgebungstemperatur: -10 bis +55°C
set-Button auf der linken Seite neben dem Micro- % Abmessungen (B x H x T): 33x52x16 mm
USB-Port der NodeMCU betatigt werden, um einen = Gewicht: 9g
Neustart auszuldsen.

Output  Serial Monitor =5

Sketch uses 283653 bytes (21%) of program storage space. Maximum is 1318720 bytes.

Global variables use 22888 bytes (6%) of dynamic memory, leaving 384872 bytes for local variables. Maximum is 327688 bytes.

Abb. 25: Ausgabe bei erfolgreicher Uberpriifung und Kompilierung des Codes

Bild 26: Ausgaben des Seriellen Monitors
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n Weitere Infos

[1] ELV-Temp-Huml Applikationsmodul Temperatur und Luftfeuchte, ELV-AM-TH1: Artikel-Nr. 157134

[2] ELV-LUX1Applikationsmodul Luxmeter 1, ELV-AM-LX1: Artikel-Nr. 158467

[3] ELV-AirPressure Applikationsmodul Luftdruck, ELV-AM-AP: Artikel-Nr. 156996

[4] Espressif Systems SoCs: https://www.espressif.com/en/products/socs

[6] NodeMCU und ESP8266 - Einstig in die Programmierung:
https://www.mikrocontroller-elektronik.de/nodemcu-esp8266-tutorial-wlan-board-arduino-ide/

[6] ESP-WROOM-32: https://www.bastelgarage.ch/esp32-esp-wroom-32

[7] Joy-IT Entwicklungsplatine NodeMCU mit ESP32: Artikel-Nr. 145164

[8] Download Arduino IDE: https://www.arduino.cc/en/software

[9] Installation der ESP-Bords in der Arduino IDE 2: https://www.youtube.com/watch?v=t4Nu50n00kA

[10]CP210x-Treiber: https://www.silabs.com/developers/usb-to-uart-bridge-vcp-drivers?tab=downloads

[11] ELV Bausatz Lichtsensor OPT3001 mit I2C-Schnittstelle I2C-LS: Artikel-Nr. 152106

[12] Download PuTTY: https://www.putty.org/

[13] Download HTerm: https://www.der-hammer.info/pages/terminal.html

Alle Infos finden Sie auch online unter: de.elv.com/elvjournal-links

A Wichtiger Hinweis

Zur Gewahrleistung der elektrischen Sicherheit muss es sich bei
der speisenden Quelle um eine Sicherheits-Schutzkleinspan-
nung handeln. AuBerdem muss es sich um eine Quelle begrenzter
Leistung gemaB EN62368-1handeln (PSI), die nicht mehrals 15 W,
gemessen nach 3 s, liefern kann. Ublicherweise werden beide
Forderungen von handelstblichen Steckernetzteilen mit ent-
sprechender Leistung erfullt.

(Ai Q Wichtiger Hinweis zum ESD-Schutz

Fdr einen ausreichenden Schutz vor elektrostatischen Entladun-
genistder Einbauin ein geeignetes Gehause erforderlich, damit die
Schaltung nicht durch eine Beriihrung mit den Fingern oder Gegen-
standen gefahrdet werden kann.

A Hinweise zur Betriebsumgebung von
Applikations- und Evaluierungs-Boards

Diese Leiterplatte ist ausschlieBlich zur Verwendung fiir vorlaufige Machbarkeitsstudien und -ana-
lysen in Labor- und Entwicklungsumgebungen durch technisch qualifizierte Elektronikexperten

vorgesehen. Dieses Gerat ist nicht flr die Verwendung von privaten Endverbrauchern vorgesehen.
Dieses Gerat darf nicht als Gesamtheit oder Teil eines fertigen Produkts verwendet werden.
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n Bau- und Bedienungsanleitung

Hinweis zu den vorbestiickten Bausatz-Leiterplatten
Sehr geehrter Kunde,

das Gesetz Uber das Inverkehrbringen, die Ricknahme und die umweltvertragliche Entsorgung von Elektro- und Elek-
tronikgeraten (ElektroG) verbietet (abgesehen von wenigen Ausnahmen) seit dem 1. Juli 2006 u. a. die Verwendung von
Blei und bleihaltigen Stoffen mit mehr als 0,1 Gewichtsprozent Blei in der Elektro- und Elektronikproduktion.

Die ELV Produktion wurde daher auf bleifreie Lotzinn-Legierungen umgestellt, und samtliche vorbestlckte Leiterplatten
sind bleifrei verlotet.

Bleihaltige Lote dirfen im Privatbereich zwar weiterhin verwendet werden, jedoch kann das Mischen von bleifreien und
bleihaltigen Loten auf einer Leiterplatte zu Problemen fihren, wenn diese im direkten Kontakt zueinander stehen. Der
Schmelzpunkt an der Ubergangsstelle kann sich verringern, wenn niedrig schmelzende Metalle wie Blei oder Wismut mit
bleifreiem Lot vermischt werden. Das unterschiedliche Erstarren kann zum Abheben von Leiterbahnen (Lift-off-Effekt)
fiihren. Des Weiteren kann der Schmelzpunkt dann an der Ubergangsstelle unterhalb des Schmelzpunkts von verbleitem
Lotzinn liegen. Insbesondere beim Verloten von Leistungsbauelementen mit hoher Temperatur ist dies zu beachten.

Wir empfehlen daher beim Aufbau von Bausatzen den Einsatz von bleifreien Loten. ELV
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Entsorgungshinweis

Dieses Zeichen bedeutet, dass das Gerat nicht mit dem Hausmdll, der Restmdilltonne oder der gelben
Tonne bzw. dem gelben Sack entsorgt werden darf.

Sie sind verpflichtet, zum Schutz der Gesundheit und der Umwelt das Produkt, alle im Lieferumfang enthaltenen
Elektronikteile und die Batterien zur ordnungsgeméaBen Entsorgung bei einer kommunalen Sammelstelle fur Elektro-
und Elektronik-Altgerate bzw. fur Altbatterien abzugeben. Auch Vertreiber von Elektro- und Elektronikgeréaten bzw.
Batterien sind zur unentgeltlichen Ricknahme von Altgeraten bzw. Altbatterien verpflichtet.

Durch die getrennte Erfassung leisten Sie einen wertvollen Beitrag zur Wiederverwendung, zum Recycling und zu
anderen Formen der Verwertung von Altgeraten und Altbatterien.

Sie sind verpflichtet, Altbatterien und Altakkumulatoren von Elektro- und Elektronik-Altgeréten, die nicht vom Altgeréat
umschlossen sind, vor der Abgabe an einer Erfassungsstelle von dem Altgeréat zu trennen und getrennt lber die 6rt-
lichen Sammelstellen zu entsorgen.

Wir machen ausdriicklich darauf aufmerksam, dass Sie als Endnutzer eigenverantwortlich fiir die Léschung personen-
bezogener Daten auf dem zu entsorgenden Elektro- und Elektronik-Altgerét sind.

Bevollmachtigter des Herstellers:
ELV Elektronik AG - Maiburger StraBe 29-36 - 26789 Leer - Germany






